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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in July 2023

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name IndexName _

FTSE A50 Index

MSCI China A 50 Connect Index _ 5.09%

HS Mainland CES120 Index
Banks Index 5%

+6.2%

CSI 300 Index +3.9%

+7.6%

% Change % Change
Equity Index Futures Access Codes
Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv 0#HMBI: 0#HCHH: 0#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg
As at 31 July 2023

Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

HSI Products HSI Futures (YoY) HSI Options (YoY)
(2023 vs 2022)

Av erage Daily Volume Open Interest Average Daily Volume Open Interest

(No. of Contracts) (No. of Contracts)
@ & 280,000 - pmm ADV (L-Axis) - 200,000 (N%g,gor&t)ra(-:tS) ADV (L-Axis) (N?I OZSOOT%%:S)
HSI Futures 143,434 (-6%) 149,607 (+31%) 240,000 - Open Interest (R-Axis) Open Interest (R-Axis)
200,000 - - 150,000 45,000 - - 300,000
160,000 -
o - 100,000 30,000 - - 200,000
Mini-HSI Futures 97,150 (-10%) 21,140 (+79%) 120,000 -
80,000 ~ - 50,000 15,000 - - 100,000
40,000 -
0 - 0 o +—~+—+++——-"1+0
HSI Options 24,234 (-6%) 129,380 (+19%) N0 A9 N o A L9 N g
S EE S S R
HSI Futures (MoM) HSI Options (MoM)
Mini-HSI Options 13,418 (+8%) 19,976 (+48%)
Average Daily Volume Open Interest Average Daily Volume Open Interest
(No. of Contracts) No. of C
(“'2%8,88'6'3?5)— ADV (L-Axis) (N?' 0588%3615) 45,000 - ADV (L-Axis) ( 2 0208%%8)
Open Interest (R-Axis) Open Interest (R-Axis)
HSI.Futures 4,096 (+57%) 59,229 (+12%) 150,000 - 1 l I - 150,000 - 150,000
Options U1 30,000 /\/\’\’
100,000 - - 100,000 - 100,000
. 15,000 -
HSI VOlatlllty 0 (_) 0 (_) 50,000 - - 50,000 - 50,000
Index Futures
0 1 I O 0 Q. > O > 0
L - [ = ooy CQATSXES
HSI Dividend §§8§§§§§2§§% 338583822853
IF:otmt Index 107 (+269%) 9,521 (+2866%) oz | o093 5022 | o023
utures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 July 2023
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

L Includes the largest and most ('000)

Index Description o _ )

liquid stocks listed in Hong Kong 217 ——HS| ——VHSI - 32 130 HSI Index Tencent
Index Level 20,078.94 (As at 31 Jul 2023) 120 - HSBC —AlA

Meituan Baba

Index Volatility (30-Day Historical) | 30.3 20 - L og 110 -
Index Avg. Day High-Low Range 243.50 (Jul 2023) 100 -

r
HSCE! Correlation (2023) 0.985 19 L 24 90 -

80 -
Hang Seng Index Futures 18 . . 20 70
May-23  Jun-23 Jul-23 May-23 Jun-23 Jul-23

Contract Multiplier HK$50

Notional Value (1 Contract) HK$1.00Mn (As at 31 Jul 2023) Distribution of HSI Index Options Ol in Month-end
Call Put
Transaction t* 38.0
g 8
Stamp Duty NA S a0
~ 31.0 @
Trading Fee HK$10 / contract 3 5
S 240 £240
SFC Levy HK$0.54 / contract = 7 Z
“ 5
Commission Rate Negotiable 3 17.0 S 17.0
© =
£
Margin as of 28 Jul 2023 HK$76,650 100 | . . . 10.0 S
0 1 2 3 012 3 456 789
Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 July 2023
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY) HSCEI Options (YoY)
HSCEI Products or*

ADV
(2023 vs 2022) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-AXis) - 700,000 120,000 + ADV (L-Axis) r 2,800,000
Open Interest (R-Axi Open Interest (R-AXis)
J - 600,000 i - 2,400,000
HSCEI Futures 193,940 (+6%) 602,555 (-1%) 200000 [ c00.000 100,000 [ 200,000
160,000 - ! 80,000 - ! !
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 -
Fut SIS 10,535 (-23%) 5,673 (+12%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - 0 0 L e e e e e e 0
N ND O A 9 N g
. ) S S S S S S
HSCEI Options 48,553 (+8%) 1,329,922 (+16%) v
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mln-l HSCEI 3,779 (+8%) 28,513 (+2%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-AxiS) - 700,000 80,000 - ADV (L-Axis) - 2,000,000

Open‘interest (R-Axis) | Open Interest (R-AXis)
220,000 - 600,000
L 500,000 60,000 - - 1,500,000
HSCEI Futures '
. 35,536 (+83%) 1,097,453 (+49%) 165,000 - . 400.000
SERE ' 40,000 - - 1,000,000
110,000 - - 300,000 ' o
.. - 200,000
HSCEI Dividend 55,000 - 20,000 - - 500,000
Point Index 1,298 (-5%) 85,256 (+48%) - 100,000
Futures O Toanzocassmes ° 0 0
58285882833 255885885553
2022 2023 2022 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 July 2023
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

Comprises the largest and
Index Description p,' ] 9
most liquid H shares 106
e H S| em—HSCEI
Index Level 6,899.31 (As at 31 Jul 2023) 104 1
102 A
Index Volatility (30-Day Historical) | 35.2 100
Index Avg. Day High-Low Range 102.82 (Jul 2023) 98 -
Correlation with HSI, CES120 (2023)| 0.985,0.933 96 1
94 -
Correlation with CSI300, FTSE A50 0.725.0.73 92 -
(2023)
90 T T T r
3-Jul  10-Jul 17-Jul 24-Jul 31-Jul

Contract Multiplier

HK$50

HSCEI & Top 5 Constituents

130 -

e HSCEI — Ping An
Tencent ——CCB
Meituan Baba
110 A
90 -
70
May-23 Jun-23 Jul-23

Distribution of HSCEI Index Options Ol in Month-end

Notional Value (1 Contract) HK$0.34Mn (As at 31 Jul 2023) Call
14.0
. =)
Transaction Cost* g 120
®© 100
Stamp Duty N/A L
& g0
s &
Trading Fee HK$3.5 / contract =
& 6.0
SFC Levy HK$0.54 / contract 3 40
£
Commission Rate Negotiable 20 | T T T . . S
0 10 20 30 40 50 60
Margin as of 28 Jul 2023 HK$29,550 Open Interest (‘000)

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 July 2023
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Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50

Volume
. . Akuna, Eclipse, I-Access, IMC, Maven, ~ (No. of Contracts)
Liquidity Providers ) .
Optiver 30.000 - ® Weekly HSI Options
25 000 - m Weekly HSCEI Options
Transaction Cost* 20,000
Stamp Duty N/A 15,000
Trading Fee HK$10 / contract 10,000
SFC Levy HK$0.54 / contract 5,000
- . 0
Commission Rate Negotiable N NN EENENN NN NSNS NSNS
AT VDO RSAINMNIN OO dITWON O o
o NN ANANNNNM
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 20,000 - ==\ eekly HS| & HSCEI Options Call
L . Akuna, Eclipse, I-Access, IMC, Mawen, Weekly HSI & HSCEI Options Put
Liquidity Providers ) 16,000 -
Optiver
12,000 -
Transaction Cost* 8,000 -
Stamp Duty N/A 4,000 -
Trading Fee HK$3.5 / contract 0 —
[ e e e S S A e e S S S S A e e
SFC Levy HK$0.54 / contract MIBVO~NS TN NRRO dFW0ONn 0 d
Commission Rate Negotiable

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 July 2023
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2023 vs 2022) _— No. of Single Stock Derivatives

Stock Futures 6,994 (-11%) 32,763 (-4%) Single Stock Futures
Stock Options 651,154 (+11%) 10,945,598 (+42%) Single Stock Options 126
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
12,000 + mm— ADV (L-Axis) 40,000 800,000 - ADV (L-Axis) - 12,000,000 ST/ EUITES
10,000 - Open Interest (R-Axis - 35,000 Open Interest (R-Axis)/f | 10,000,000
8,000 [ 52000 600,000 1 8000000  * Products
et - 25,000 Bt
6.000 - . 20000 400,000 - - 6,000,000 > 3 A-shares ETFs futures contracts
4,000 - 15,000 4,000,000 » Total 98 stock futures contracts
- 10,000 200,000 1 - 2,000,000
2,000 - - 5.000 ,000,
0 0 T T T T T T T T T T T T 0
N D0 O NS
P AT P
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) (No. of Contracts) ( ) (No. of Contracts) » 3 A-shares ETFs options contracts
. ADV (L-Axis) . 800,000 - ADV (L-Axis - 12,000,000 i
10,000 Open Interoat (RAxis) | 40:000 Open Interest (BeAxis) > Total 126 stock options contracts
8,000 - ] ]
30,000 600,000 \/\/J\/ 8000000 ¢ Market Makers (MMs)
6,000 -
- 20,000 400,000 > 3 types of market makers (PMM/ CQMM/
4,000 1 - 4,000,000 QRbAbi))
2000 | L 10,000 200,000 - »> CQMM to provide 50 series continuous
’ quotations
01 0 0 >0 > 0
oan >0 PR Nl oan c = s cs
2382858852433 38585852833
2022 2023 2022 | 2023

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 31 July 2023
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Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 31 July 2023)

e Tracks the largest technology companies
Index Description . .
listed in Hong Kong

Hang Seng TECH Index Futures & Options & Futures Options

HK$50 per index point
HK$227K (As at 31 July 2023)
Options: 5

Contract Multiplier

Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*

Stam p Duty N/A
Trading Fee HK$5.00 / contract
SFC Levy HK$0.54 / contract

Providing investors with a tool to manage their risk exposure
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 July 2023

Open Interest
(No. of Contracts)

300,000 -
250,000
200,000
150,000
100,000

50,000

Aug

o
[}
n

5 2 9l 2 5 5 > £ S
c z 48 S ¢ =< g 3 °
2022 | 2023 |

Average Daily Volume (as of July 2023)

ADV
(No. of Contracts)

140,000 -
120,000
100,000
80,000
60,000
40,000
20,000
0

Q
[}
2]

2022 2023

Volume and Open Interest continue to growth
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MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of July 2023)

. Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
Index Level 2,146.80 (As at 31 July 2023) (No. of Contracts)
20,000 -
Index Volatility (30-Day Historical) | 17.0
15,000
Index Avg. Day High-Low Range 18.91 (July 2023)
10,000
CSI300 Correlation (2023) 0.958
5,000
FTSE A50 Correlation (2023) 0.975
0
o)
MSCI China A 50 Connect Index Futures n
Contract Multiplier US$25 2022 | 2023 |
Notional Value (1 Contract) US$0.05Mn (As at 31 July 2023) Open Interest (as of 31 July 2023)
Average Quote Size US$0.27Mn (5 Contracts)
Open Interest
(No. of Contracts)
25,000 -
Transaction Cost*
Stamp Duty N/A 20,000 -
Trading Fee US$0.5 / contract
15,000 -
SFC Levy US$0.07 / contract
Margin as of 28 Jul 2023 US$2,770 10,000 _
2 & 8 3 8/ 8 8 8 8 3 5 3
< v © zZz Al L = < s » 7
2022 | 2023 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 July 2023



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$45K (As at 31 July 2023)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 July 2023

Open Interest (As of 31 July 2023)

Open Interest
(No. of Contracts)

100,000 -
90,000 -
80,000 -
70,000 -
60,000
552485823353
2022 | 2023

Average Daily Volume (As of July 2023)

ADV
(No. of Contracts)

30,000 -

20,000 -

10,000 -

O -

o
[}
2]

2022 2023

Volume and Open Interest continue to growth
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEI Correlation (2023)

MSCI AxJ Futures

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

532.97 (As at 31 July 2023)
14.8

5.17 (July 2023)

0.909

0.9

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$53K (As at 31 July 2023)
US$0.27Mn (5 Contracts)
0.0 index points (July 2023)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 28 Jul 2023

N/A
US$0.5 / contract
US$0.07 / contract

US$1,930

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 31 July 2023

Open Interest (31 July 2023)

Open Interest
(No. of Contracts)

1,200 -
1,000 -
800 -
600 -
400 -
200 -

0

Aug
Sep
Oc
Nov
Dec
Jan
Feb
Mar
Ap
May
Jun

2022 | 2023

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCIAX] MSCI China MSCI HK
120 - MSCISG e MSClIndia oo MSCI Indonesia
----------------- MSCI Korea - MSCI Malaysia MSCI Pakistan

................. MSCI Philippines MSC| Taiwan

Jul

SCI Thailand

80 T T

May-2023 Jun-2023 Jul-2023

MSCI AxJ is a well-established benchmark representing Asia

regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEIl Correlation (2023)

10 largest and most representative
HKEX-listed mainland banks stocks

2,472.19 (As at 31 July 2023)
318

31.80 (July 2023)

0.744

0.755

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 28 Jul 2023

HK$50

HK$0.12Mn (As at 31 July 2023)
HK$0.62Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$6,520

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 July 2023

5-Min Avg. Bid-Ask Spreads (31 July 2023)

HSMBI Futures

CEB Bank 6818.HK 0.46%
Minsheng Bank 1988.HK 0.45%
ABC 1288.HK 0.43%

Bank of China 3988.HK

PSBC 1658.HK
ICBC 1398.HK

CITIC Bank 998.HK
Bankcomm 3328.HK
CCB 939.HK

CM Bank 3968.HK

Index & Constituents 3-Month Performance (Rebased to 100)

115
110
105
100
95
90
85
80

May-2023

——HSMBI
ICBC (1398.HK)

——CCB (939.HK)
BOC (3988.HK)

1 ——ABC (1288.HK)

Jun-2023 Jul-2023

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index

80 A-Shares and 40 HK-listed Mainland

Index Description ) ) )
China H-shares, P-chips, and red chips

Index Level 5,505.10 (As at 31 July 2023)
Index Volatility (30-Day Historical) | 18.8

Index Avg. Day High-Low Range 61.55 (July 2023)

CSI300 Correlation (2023) 0.88

FTSE A50 Correlation (2023) 0.89

5-Min Avg. Bid-Ask Spreads (31 July 2023)

CES120 Futures | NA

CSOP FTSE A50 ETF (2822.HK) _ 0.16%

i 0,
R 0 et S X iShares A50 ETF (2823.HK) F 0.11%

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.28Mn (As at 31 July 2023)
Average Quote Size HK$1.38Mn (5 Contracts)

Average Bid-Ask Trading Spread| N/A

Liquidity Providers N/A

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

130 eeeCES120 Index Tencent CCB
Ping An - China Mobile

120 -

Transaction Cost* 110 -
’/A/*\/

Stamp Duty N/A 100 -

Trading Fee HK$5 / contract %

SFC Levy HK$0.54 / contract -

Margin as of 28 Jul 2023 HK$13,590 I?/I%y-2023 JUN-2023 JuL2023

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 July 2023

CES120 Futures can be used to hedge A-share positions

15



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan  |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



